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Introduction
This user guide provides basic information on setting up and running Tra
Analysis. In order to ensure optimum operation of this application, read 
material in this user guide before attempting to run Traffic Analysis.

Overview
Traffic Analysis performs the following functions:

— Collects traffic data from a specific system’s Meridian 1

— Maintains a database of collected traffic data

— Defines report and graph parameters

— Generates reports to extract significant information from raw traffic da
such as trunk usage, peak periods, process loads and junctor and lo
traffic

About this user guide
This user guide is intended as an introduction to the Traffic Analysis 
application as well as an overview of its major functions. It discusses how 
can best use it to manage traffic data and generate meaningful reports.

This user guide does not discuss each Traffic Analysis function and comm
in detail. It only discusses the major functions and how they are accessed
detailed information on each Traffic Analysis function and command, us
on-line Help. You can use Help to obtain information for topics either direc
or via its index and word-search functions. You can obtain context-sensi
help on any topic by simply pressing <F1> during the Traffic Analysis 
session or by clicking Help  in the dialog or window in which it appears.
OTM Traffic Analysis User Guide
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Conventions used in this user guide
This user guide uses the following terms.

— Computer system refers to the hardware and software of an IBM-PC™ 
100% compatible PC.

— Windows refers to Microsoft® Windows® 95 and Windows NT® V4.0.

— Mouse refers to any standard PC pointing device. Common mouse 
actions include point, click, right-click and double-click.

— Standard Windows terminology includes: icon, window, dialog box (or 
dialog) and menu.

— Angle brackets denote a single keyboard key. For example, <Esc> 
denotes the Escape key, labeled Esc on PC keyboards. Angle brack
with multiple keys denote keyboard keys to use simultaneously. For
example, <Ctrl-Alt-Del> denotes the key sequence for rebooting a P

— This font  is used to designate buttons, menu choices and information 
are to enter.

Traffic Analysis system sizing guidelines
System sizing for Traffic Analysis must consider several factors to ensur
adequate capacity and throughput to retrieve, store and report on traffic 
The major factors are as follows.

1 Does the system have enough free disk space to store and maintain
traffic data?

2 Is there sufficient communications bandwidth to perform traffic data 
collection from all systems in time?

3 Does the system have sufficient resources to provide reports on tim
P0910103 Standard 1.0 July 2000
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Traffic Database capacity
The size of the Traffic Database varies depending on the Meridian 1. Th
Traffic Database will also grow rapidly depending on how much data is k
for reporting purposes. Since the active database should normally be arch
monthly (thus retaining the previous month’s traffic data for reporting as w
as updating statistics on the current month), you should expect to store a
two months of data in the Traffic Database. Older data should be routine
archived and moved to external storage. Since, however, it will normally
stored transiently on disk as well, you should reserve capacity for the arc
operation.

The actual size of the database depends on your specific configuration 
parameters such as: the number of loops, trunks, consoles, etc.

Use the following example formula to estimate the size of the Traffic 
Database (including a one-month archive). This example formula assum
that traffic data collection will be scheduled for each hour in the day (i.e., y
are not excluding any time for maintenance on the Meridian 1) and that y
have 31 days of archived data and 61 days of active data.

24 hours x (61 days + 31 days of archive) = 2208 Traffic Database 
samples

Thus, you should allow for 2500 samples (this will allow for temporary file
used during reporting). Use the following calculation to determine the to
bytes required for one (1) Traffic Database sample. Once you have calcu
the total bytes for 1 sample, you must then multiply it by the total number
samples.

1 Traffic Database sample =

[(Network Loops x 29) + (Junctor Groups x 17) +

((C/S Links + A/M Links) x 240) + (D-Channels x 115) +

(Multi-Purpose ISDN Signaling Processors x 59) +

(Customers x 424) + (Route Lists x 299) +

(Individual Attendants x 39) + (Network Classes of Service x 35) +

(Incoming Trunk Groups x 35) + etc.]
OTM Traffic Analysis User Guide



Page 4 of 20  Introduction

n the 

ble 

ted 
ta 
ata. 
ng 
uired 
on, 

f 

n 

ms, 
en 

e 10 
bout 

ion 
Communications throughput
The amount of time that it takes a system to collect traffic data depends o
number of systems to collect, the Meridian 1 configuration, the 
communication line speed and the number of communication ports availa
on the Optivity Telephony Manager (OTM) system.

Traffic data is produced hourly by the Meridian 1. This data is either collec
hourly by Traffic Analysis from the Meridian 1 or daily from an optional da
buffer device which is connected to the Meridian 1 and stores the hourly d
Once retrieved, the data is compressed by a 4-1 ratio for reporting. Havi
calculated the size of the database sample, you can calculate the time req
to transfer the data. These calculations allow for dialing, connection, log
traffic data requests, logout and disconnect.

— No buffer device—hourly:

Seconds to Collect Sample = [Setup + (Compression Ratio x Size o
Traffic Sample) ÷ Modem Speed]

— With a buffer device—daily:

Seconds to Collect Sample = [Setup + (Hours per Day x Compressio
Ratio x Size of Traffic Sample) ÷ Modem Speed]

Note: For both cases, allow 40 seconds for setup and allow 85% 
throughput on modem speed for buffer protocol.

The goal is to ensure that the time required to collect data from all syste
using all available communications paths, is less than the interval betwe
collection cycles. Note that modem speeds are typically rated by baud 
rate—which roughly translates to bits per second. As a rule of thumb, us
bits per byte in calculating modem speed. A 2400 baud modem delivers a
240 bytes per second.

Sample calculation 
The following is an example for Traffic Database sizing and a communicat
throughput estimate:

Switch Option 61 + 2400 baud modem (no buffer device)

7 Network Loops x 29 = 203

1 Junctor x 17 = 17

1 Link x 240 = 240
P0910103 Standard 1.0 July 2000
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Hourly:

Daily:

System resources
The resources required to produce reports are provided by the Windows
environment and are affected by activities on the system. System loads 
CPU, memory, disk storage and bandwidth. A typical application such a
word processor or electronic mail might generate little CPU load, but mig
put large demands on memory.

In any Windows environment, memory (RAM) can be extended through 
use of virtual memory. Virtual memory allows the PC to use disk space a
it were RAM. Both RAM and virtual memory must be available in sufficien
quantity for all concurrent system activities. A shortage of memory will eith
prevent an application from running or will slow the overall system.

CPU loading depends on the frequency and number of reports. While th
system is designed to concurrently generate multiple reports (only for 
multiple systems), the system runs at maximum throughput when genera
one report at a time.

0 D-Channels x 115 = 0

0 MISP’s x 59 = 0

1 Customer x 424 = 424

9 Route Lists x 299 = 2691

1 Ind. Attendant x 39 = 39

0 NCOS’s x 35 = 0

2 In. Trunk Groups x 35 = 70

3,684 bytes total

Disk Requirements = 2,500 x 3,684

= 9,210,000 bytes (assumes two months on-line

Data Collection Duration = 40 + (4 x 3,684) ÷ (240 x 0.85)

= 112 seconds = 1:52 minutes each hour

Data Collection Duration = 40 + (24 x 4 x 3,684) ÷ (240 x 0.85)

= 1,774 seconds = 29:34 minutes each day
OTM Traffic Analysis User Guide
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The Windows Print Manager ensures that data from separate reports ar
mixed-up on the printer. In order to perform this function, the Print Mana
temporarily stores reports on disk (the Print Manager has a backlog limit
99 print jobs). Therefore the CPU speed, available virtual memory and pri
speed dictate the time required to produce the reports and the practical sy
limits to traffic data throughput.
P0910103 Standard 1.0 July 2000
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Gettin g Started
This chapter contains information used for running and setting up Traffic
Analysis for initial use.

Before using Traffic Analysis, you must install and configure it as part of
Optivity Telephony Manager (OTM) system. Refer to Getting Started in t
OTM Common Services User Guide for complete details on installing Traffic
Analysis and assigning it to a site and system.

System access
To access Traffic Analysis from the OTM Navigator, click the desired sit
and system and click Traffic Analysis  from the Telemanagement menu. Th
main Traffic Analysis window will appear.

After you have assigned Traffic Analysis to a site and system, you can u
to collect traffic data, generate reports and graphs and maintain its datab

Before you can begin collecting traffic data and report on it, you must en
the parameters for the data collection and report generation processes. 
following section provides a complete example of how to accomplish the
tasks, as well as instructions for scheduling and starting data collection f
the Meridian 1.

WARNING
When a Limited Access Password (LAPW) is defined to collect traffic 
data from Overlay 2, configure the password to have access to all 
customers by setting the CUST prompt to ALL. For more information 
about Limited Access to Overlays, see the X11 Software Features 
Guide.
OTM Traffic Analysis User Guide
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Traffic Anal ysis exam ple
The following example is provided to assist you in setting up Traffic 
Analysis.

Note: The instructions in this example assume that you have 
successfully installed the OTM software and completed the OTM 
configuration tasks described in the OTM Common Services User Guide

This example illustrates how to accomplish the following tasks:

— Run OTM and open a site and system

— Run Traffic Analysis

— Set up the Meridian 1 for traffic collection

— Collect traffic data from the Meridian 1

— Print a D-Channel Report that contains data for incoming and outgo
calls

Run OTM and open site/system
Before you run Traffic Analysis, you must first run the OTM Navigator an
open this site and system. You can then select Traffic Analysis from the 
Telemanagement menu in this system’s window.

Note: This system must already have been created using the System
Configuration function. Refer to the OTM Common Services User Guide 
for more details on the System Configuration function.

Perform the following steps to open the site and system.

1 Run the OTM Navigator by clicking the OTM Navigator  icon. At the 
Login dialog which appears, enter your user ID and password and c
OK to continue.

2 To open the site and system for this example (e.g., site name is Acm
Company and system name is Head Office), click Acme Company  in the 
OTM Navigator window and double-click Head Office  from this site.

This will access the system window for Head Office.
P0910103 Standard 1.0 July 2000
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Run Traffic Analysis
Perform the following steps to run Traffic Analysis.

1 From the system window, click the Telemanagement  menu item. This 
will display the OTM applications which have been assigned to the 
system Head Office under Telemanagement  (e.g., Telecom Billing 
System, Call Tracking and Traffic Analysis).

2 To run Traffic Analysis, double-click Traffic Analysis from this menu. 
The Traffic Analysis main window will appear.

Figure 1
OTM Navigator Site/System
OTM Traffic Analysis User Guide
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Assi gn Traffic Anal ysis to s ystem (if not alread y assi gned)
If Traffic Analysis has not been assigned to this system, it will not appea
the Telemanagement  menu. To assign Traffic Analysis to this system, 
perform the following steps.

1 Click Properties  from the File drop-down menu to access the System
Properties dialog.

2 From the System Properties dialog, first enter a communications pro
for Traffic Analysis by clicking the Communications  tab. In the 
Communications Profile field, enter a profile for Traffic Analysis.

3 Click the Applications  tab to assign Traffic Analysis to this system. 
From the Communications Profile drop-down list box, select the 
communications profile which you just entered in the Communicatio
tab. Click Traffic Analysis  in the Applications list box to highlight it and
turn on the Enable  check box. Notice that the flag Yes will appear in the 
Enabled field next to Traffic Analysis in this list box.

4 Click OK to assign Traffic Analysis to this system. The Traffic Analys
icon will appear under Telemanagement  for the system Head Office .

Figure 2
Traffic Analysis main window
P0910103 Standard 1.0 July 2000
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Set up Meridian 1 for traffic
Follow these steps to set up the Meridian 1 for traffic data collection. Yo
only need to perform this step once when you initially set up Traffic Analy

1 Click Traffic Data Collection  from the Maintenance drop-down menu o
the Traffic Analysis main window.

2 Turn on the Set up PBX for Traffic  check box. This enables the 
Meridian 1 to collect and transmit data.

Collect traffic data from Meridian 1
Follow these steps to collect traffic data from the Meridian 1.

1 Click Traffic Data Collection  from the Maintenance drop-down menu.

2 Turn on the Schedule Traffic Collection  check box.

3 From this dialog, click OK to start the traffic data collection. This will 
schedule the load of traffic data from the Meridian 1 to a temporary d
file TRAFFIC.DMP for parsing and report processing.

Once the system collects the initial traffic data, it will then parse it into fil
with the names TFnnnn.DAT  (where nnnn  identifies the type of report which 
will be generated).

Print traffic report for incoming & outgoing calls
Follow these steps to print a report for incoming and outgoing calls.

1 Before requesting a printed report, you must select your printer as th
output device. From the Traffic Analysis window, click File  and click 
Specify Output Device from its drop-down menu. In the resulting 
dialog, click Printer  and click OK.

2 Click Print Setup  from the File drop-down menu to select the printer fo
this report. Click OK to save this information and return to the Traffic 
Analysis main window.

3 To print the report, click System Reports  from the Reports drop-down 
menu. The System Reports dialog appears.

4 Click on the Report  down arrow to open the list of available system 
reports. To select the D-Channel Report, click D-Channel .
OTM Traffic Analysis User Guide
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5 Click on the Profile  down arrow to view a list of available profiles for the
D-Channel report. Select DCHANL.PRO - D-Channel Report . This is the 
default report profile used to select data for the D-Channel Report.

6 Click Edit  next to the Profile list box to access the Profile Editor for th
DCHANL.PRO report profile. A dialog will appear listing the profile’s
description, options and parameters. You can enter information here
tailor the report.

7 In the Options list, click to select only the following items:

Incoming
Outgoing

De-select any other highlighted items in the list.

8 To save this default profile to a new profile name, click Save As  from 
the File drop-down menu. In the Save As dialog, type: DCHANL1.PRO  
for the file name.

9 Click Close  from the File drop-down menu to exit the Profile Editor an
return to the System Reports dialog.

10 Click on the Filters down arrow to view a list of available filters for th
report. Click None . This clears the Filters box so that the report includ
all collected traffic data.

11 Click OK to print this report. A report status box indicates printing 
progress.

Help
As with the other OTM applications, Traffic Analysis contains an extensi
Help facility which provides you with details on all of its functions and 
commands. At any time during your Traffic Analysis session, you can pr
<F1> or click Help  to access information on a specific topic. You can also
click Help Topics  from the Help drop-down menu of the Traffic Analysis 
main window and search for Help using the Windows Help search functio

To obtain help for a topic, press <F1> or click Help  from the currently 
selected dialog or window. This will access the Windows Help function a
display context sensitive help information on the current topic.

Once you have accessed Help, use it to scroll through the other help top
search for a specific topic and print help information.
P0910103 Standard 1.0 July 2000
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User’s Reference
This chapter contains a general overview of the main Traffic Analysis 
functions as they are accessed from its main window. It briefly describes t
main function and purpose. For complete details on each of these functi
and their operation, refer to the Traffic Analysis on-line Help function.

File menu
This menu contains functions used to select an output device, set up a pr
and exit from Traffic Analysis.

To access these functions, click File  from the main window and select from
the following menu items:

— Select Output Device

— Print Setup

— Close

Reports & graphs
The Traffic Analysis reports and graphs provide the details for the traffic d
collected from the Meridian 1. These can be printed to an output device,
the screen for review, or to a disk file. Traffic Analysis provides a set of 
profiles and filters to allow you to tailor the output of these reports and gra
to suit your needs. Once you have collected the traffic data from the 
Meridian 1, use the commands in the Reports and Graphs menus (follow
sections) to generate the required reports and graphs.

Reports menu
The Reports menu contains functions and commands to print reports bas
the collected traffic data.
OTM Traffic Analysis User Guide
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The following are the reports available from Traffic Analysis.

— System Reports

• Network Loops

• Service Loops

• Dial Tone Delay

• Processor Load

• Selected Terminals

• Junctor Group

• Command and Status Links and Application Module Links

• D-Channel

• Multi-Purpose ISDN Signaling Processor Traffic

• Multi-Purpose ISDN Signaling Processor DCH Management

• Multi-Purpose ISDN Signaling Processor Messages

• ISDN Generic Functional Protocol

• General Microcellular Operational Measurements

• UWIN Operational Measurements
P0910103 Standard 1.0 July 2000
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— Customer Reports

• Networks

• Trunks

• Customer Console Measurements

• Individual Console Measurements

• Feature Key Usage

• Radio Paging

• Parallel Radio Paging

• Serial Radio Paging

• Call Park

• Messaging and Auxiliary Processor Links

• Output Message Traffic

• Input Message Traffic

• Message Attendant Queue

• Telephone Set Status

• Telephone Messaging

• Network Attendant Service

• Semi-Permanent Connection Links Establishment

• Music Broadcast

• RAN Broadcast
OTM Traffic Analysis User Guide
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— Customer Network Reports

• Route Lists

• Off Hook Queuing

• Call Back Queuing 

• Remote Virtual Queuing

• Network Class-of-Service

• Incoming Trunk Group

— System Threshold Reports

• Dial Tone Speed

• Loop Traffic

• Junctor Traffic

• Super Loop Traffic

— Customer Threshold Reports

• Incoming Matching Loss

• Outgoing Matching Loss

• Average Speed of Answer

• Percent Last Trunk Busy

• Off-Hook Queue Overflow Threshold

— Customer Summary Reports

• Traffic System Summary

• Trunks Summary

• Customer Console Summary

• Individual Console Summary

Graphs menu
Similar to the Reports menu, the Graphs menu contains functions and 
commands to print graphs based on the collected traffic data.
P0910103 Standard 1.0 July 2000



 User’s Reference Page 17 of 20

ports 
nter 

ria 
ilarly.

hat 
ters. 
ct the 
es 
The following are the graphs available from Traffic Analysis.

— System Graphs

• Network Loops

• Processor Load

— Customer Graphs

• Trunks

• Customer Console Measurement

• Messaging and Auxiliary Processor Links

— Customer Network Graphs

• Route Lists

• Off Hook Queuing

— System Threshold Graphs

• Loop Traffic

• Super Loop Traffic

— Customer Threshold Graphs

• Percent Last Trunk Busy

Generating reports & graphs
To generate a report or graph, select the report or graph type from the Re
menu or the Graphs menu. When the Report or Graph dialog appears, e
its optional profile and filter information and click OK to print it.

The following is an example dialog in which you can enter reporting crite
and generate the report. The corresponding Graphs dialog operates sim

Click on the drop-down button to display a list of the reports or graphs in t
category. Each entry in the list has one or more associated profiles and fil
After you click to select a report (or graph), use the same process to sele
appropriate profile and filter. Edit buttons next to the Profile and Filter box
let you review and modify the selected profile and filter.
OTM Traffic Analysis User Guide
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Profiles
Profiles define the kind of information to include in a report or graph. Ea
report or graph requires at least one profile. Traffic Analysis includes sev
default profiles for commonly-used reports and graphs. You can define a 
profile by editing one of the default profiles and saving your work under 
new profile name. Profile file names use the .PRO extension.

Filters
Filters define the range of traffic data to be included on a report or graph, s
as data for a specific month. Filter file names use the .FLT extension.

Exportin g Reports
The Export function allows you to export traffic data from its reports to di
files in specific formats. This function is invoked when a report is genera
to screen.

After you have completed your work with profiles and filters, click on one 
the following buttons to proceed:

OK to produce the report or graph

Schedule  to specify the time at which the report or graph is to be 
produced

Help  to obtain help for this function

Cancel  to cancel the request and return to the main window

Figure 3
System Reports dialog
P0910103 Standard 1.0 July 2000
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When you have printed or scheduled the output, the system will return to
Traffic Analysis window.

“What-if” menu
In addition to generating reports and graphs, you can use Traffic Analysi
ask “What if?” questions on data output from the Meridian 1. This is 
accomplished by defining scenarios and viewing hypothetical results. Th
“What if” scenarios provide different results based on new situations that 
input into the system.

To define a scenario, select it from the list of available scenarios. Next, se
a profile to define its contents and a filter to set a range for its data. This
process is similar to producing a report or graph.

You can define the following “what if” scenarios:

— Processor Load

— Trunk

— Attendant Console

To access this function, open the What-if menu in the Traffic Analysis 
window.

Processor Load scenario
The Processor Load scenario provides information on rated capacity for y
Meridian 1. It lists overall and itemized information on the busy hour and t
number of attempts at the busy hour rate over the rated capacity. It allows
to adjust the call attempts or the CPU type and view the resulting chang
busy hour CPU loading time.

Note:  In the filter for this scenario, enter a range with a minimum of 2
hours to make the scenario data valid.

Trunk scenario
The Trunk scenario allows you to determine the offered traffic, monthly c
and probability of blocking a trunk or a set of trunk groups. Use this scena
to change the offered traffic or the probability of trunk blocking and view t
results for the trunks.
OTM Traffic Analysis User Guide
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Attendant Console scenario
The Attendant Console scenario provides information on console respon
and service levels. Use this scenario to change response times and serv
levels and view the results.

Maintenance menu
Traffic Analysis provides maintenance functions which are used to: manu
collect traffic data; manage the Traffic Database; edit report profiles and
filters; and edit text files.

Traffic Database
The Traffic Database function is used to archive a range of traffic data as 
as merge, delete and reindex traffic data files.

Traffic Data Collection
The Traffic Data Collection function is used to initiate data collection from
the current system’s Meridian 1. Use this function to set up the Meridian 1
traffic collection and schedule traffic data collection. For a complete list o
script files used for traffic data collection, refer to Appendix A: Script File 
Summary of the Common Services User Guide.

Profile Editor
Every report or graph requires a profile that defines the data to be include
a report or graph. OTM provides default profiles for common reports and
graphs. Use the Profile Editor to view and edit the options and paramete
a profile. You can also use profiles to store and manage sets of configura
and customization information.

Filter Editor
Filters define the range of traffic data to be included in a report or graph. 
Filter Editor allows you to create or edit report filters.

Text File Editor
In certain cases, you may periodically need to view or edit a text file used
Traffic Analysis. For example, you may edit the traffic data file collected 
from the Meridian 1 to correct any errors before the system processes the
Use the Text File Editor command to edit any text files for Traffic Analys
P0910103 Standard 1.0 July 2000
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